# Table of Contents

DxO PureRAW User Guide ................................................................................................................. 1  
General overview .......................................................................................................................... 2  
  About DxO PureRAW .................................................................................................................. 3  
Settings ........................................................................................................................................ 6  
  System requirements .................................................................................................................. 7  
  Installation, license activation, and deinstallation ..................................................................... 8  
  Preferences and help .................................................................................................................... 12  
Interface ...................................................................................................................................... 16  
  User interface ............................................................................................................................ 17  
  Keyboard shortcuts ..................................................................................................................... 26  
Adding and optimizing photos ...................................................................................................... 27  
  Preparing photos for optimization ............................................................................................ 28  
  Optimizing photos ....................................................................................................................... 40  
  Verifying and comparing photos ............................................................................................... 50  
Working with optimized images ..................................................................................................... 54  
  Exporting to an application ......................................................................................................... 55  
  Workflow with Lightroom Classic ............................................................................................... 60  
  Workflow with Camera Raw and Photoshop ............................................................................ 68
Welcome to the user guide for DxO PureRAW, the program that uses DxO’s demosaicing, optical correction, and denoising technologies to produce high-quality RAW files for post-processing in Adobe Lightroom Classic, Lightroom, Camera Raw, and Photoshop.

To find all the information you need about installing, activating, and using the program, as well as instructions about how to use PureRAW with Lightroom, Camera Raw, and Photoshop, just follow the table of contents in the pane on the left.
General overview
About DxO PureRAW

DxO PureRAW uses a number of proprietary technologies to help you get the most out of your images.

- **Role and benefits**
- **DxO technologies used**
Role and benefits

The role of DxO PureRAW is both very simple and decisive in improving the quality of the digital images you will work with. Indeed, by applying DxO optical corrections and denoising to your RAW files, and then performing the rest of the processing of your photos in your usual editing program, you will enjoy the best of both worlds.

You’ll be able to generate linear DNG files for post-processing in Adobe Lightroom Classic, in Adobe Lightroom (desktop, mobile, and web), and in Adobe Camera Raw, as well as in any software that supports this format. You can also generate JPEGs that are ready to use, especially for sharing (web, social networks, etc.).

DxO’s expertise in correcting lens flaws and optimizing sharpness, as well as in noise handling, gives you a solid, high-quality foundation for getting the most out of your photos.

Simply load your photos into DxO PureRAW, select the optimization options (Optics Module to be applied, type of noise reduction) and the output options (format, destination), and then start processing the images (which includes batch processing). The program allows you to check the results directly and compare the optimized images with the original ones, before your export them to your usual photo software.

The support for cameras and lenses (using DxO Optics Modules) is exactly the same as that offered by DxO PhotoLab.

Reminder: DxO PureRAW works only with RAW files.

You will also find a slide-based overview of the role, function, and technologies of DxO PureRAW in “What is DxO PureRAW?” in the Help menu.
DxO technologies used

DxO Optics Modules

After you add your images to DxO PureRAW, the program offers to download the DxO Optics Module(s) corresponding to the camera/lens pair(s) you use so as to automatically perform adjustments for the following:

- Vignetting: darkening of image borders
- Distortion: deformation of straight lines
- Chromatic aberration: colored fringes along strongly-contrasted contour lines
- Lens sharpness: homogenization and optimization of the entire image

All these corrections are applied without any need for you to intervene or make manual adjustments; all you have to do is simply approve the download of the automatically proposed Optics Modules.

DxO Labs currently offers over 60,000 Optics Modules created in its own labs, and regularly adds new modules to support even more cameras and lenses.

For more information about DxO Optics Modules and their corrections, see: https://www.dxo.com/en/technology/camera-and-lens-corrections/

DxO HQ, PRIME, and DeepPRIME denoising

DxO PureRAW also lets you reduce and even eradicate digital noise not only in your images taken at high sensitivities, but also in images taken at lower sensitivities (including daylight), because depending on the camera, some images may be grainy or have noise in the shadows that may become apparent when you lighten them. The program offers you the following noise reduction technologies:

- HQ: This is the standard DxO denoising method, which combines both efficiency and speed.
- PRIME: This technology analyzes your image in depth to accurately distinguish details from noise, resulting in images with preserved details and colors. Due to the intensity of the analysis and calculations, this method requires more time to optimize the images, depending on their quantity, size, and the power of your computer.
- DeepPRIME: This technology, based on artificial intelligence and deep learning, goes even further in analysis, image demosaicing, and noise processing, for spectacular results that push the limits of even the oldest cameras, and can give a new lease on life to even your oldest digital photos. Equally intensive analysis and calculations take advantage of the power of your graphics card.

For more information about DxO denoising methods and technologies, see: https://www.dxo.com/en/technology/deepprime/
Settings
System requirements

**Microsoft® Windows®**
- Intel® Core™ 2 or AMD Athlon™ 64 X2 or higher (minimum; Intel® Core™ i5 recommended)
- 4 GB of RAM (8 GB or more recommended)
- 4 GB minimum hard disk space
- Microsoft® Windows® 10 version 1809 minimum (64-bit) or later recommended

**Apple® macOS®**
- Intel® Core™ i5 minimum recommended or Apple Silicon
- 4 GB of RAM (8 GB or more recommended)
- 4 GB minimum hard disk space
- macOS 10.14 (Mojave), 10.15 (Catalina) or 11.0 (Big Sur)

**GPU acceleration (graphics card)**
- At minimum, series NVIDIA GeForce 8, ATI Radeon HD2000, Intel HD Graphics 2000 or Apple Silicon
- If the graphics card is not compatible, graphic acceleration will be inactive and replaced by the CPU

**Supported image formats**
Supported formats and cameras will continue to evolve as DxO PureRAW is updated.
- DxO PureRAW supports all current RAW files, with the exception of images from Fujifilm cameras using XTrans sensors.
- Original DNG files from cameras using this format
- DNG* files from RAW formats supported by DxO and converted with Adobe Lightroom Classic, Lightroom, Camera Raw, or Adobe DNG Converter

* DxO PureRAW does not support compressed DNG files and DNG files obtained by fusing photos from Adobe Lightroom Classic, Lightroom, or Camera Raw.
On this page you will find instructions for:

- Downloading
- Installation
- License activation
- Deinstallation

Downloading

You can download DxO PureRAW at https://www.dxo.com/dxo-pureraw/download/. The downloaded file is saved in your Downloads folder.

To access this folder on macOS, open the Finder and click on the Downloads folder, usually displayed in the list on the left. The installation file has the extension ".dmg."

To access this folder on a Windows PC, click on the Start button, then on your user name. In the window that opens, double-click on the Downloads folder; the installation file has the extension ".msi."

Installation

To install DxO PureRAW on Mac:

1. Find the installation disk image file (.dmg) that you have downloaded and double-click on it.
2. In the window that opens, simply slide the DxO PureRAW icon onto the Applications folder.
3. After the installation of DxO PureRAW is complete, you can access it in your Applications folder and add it to your Dock by opening
DxO PureRAW, then right-clicking on its icon in the Dock and selecting “Keep in Dock” in the Options menu.

To install DxO PureRAW on PC:

![DxO PureRAW Setup](image1)

**Welcome to the DxO PureRAW Setup Wizard**

The Setup Wizard will install DxO PureRAW on your computer. Click Next to continue or Cancel to exit the Setup Wizard.

![DxO PureRAW Setup](image2)

**End-User License Agreement**

Please read the following license agreement carefully.

**IMPORTANT - READ CAREFULLY**

This Use License Agreement (the “Agreement”) is a legal agreement between you (either an individual or a single entity - hereafter “you” or “your”) and DxO Labs for the DxO Labs Software(s) installed at your workstation (the “Software”). If you do not agree to be bound by the terms of this Agreement, do not install the Software. Your acceptance of the Software and present Agreement will be deemed to occur at the date of your first installation of the Software. Therefore, from your first use of the Software, you agree that DxO Labs or the owner of any Third Party Software included in the Software will be entitled to enforce the terms of the Agreement against you.

![DxO PureRAW Setup](image3)
Installation windows on Mac (left) and on PC (right)

1. Find the installation file (.msi) you downloaded and double-click on it.
2. The installer will guide you through a number of steps, including approval of the license agreement and the application default location (C:Programs\DxO).
3. After the installation of DxO PureRAW is complete, you can access it in the Programs > DxO > DxO PureRAW folder (create a shortcut on your desktop or pin the program in your taskbar).

License activation
The first time you launch the program after installation, you will be prompted to enter your registration key. This window will appear at each launch as long as you have not entered the key (you have a 31-day trial period, however).

The activation window also allows you to purchase your license from the DxO online store.

**Deinstallation**

To deinstall DxO PureRAW:

- Mac: Go to the Applications folder and drag the DxO PureRAW icon into the trash.

- PC: Use the Windows application deinstaller, or relaunch the DxO PureRAW installer and follow the steps.
Preferences and help

- Preferences
- Help

Preferences

Accessing Preferences (Mac, left; PC, right)

Preferences window (General)

Language: English

DeepPRIME acceleration: Auto selection

Changing this setting requires DxO PureRAW to be restarted.
Selecting partially supported GPUs (identified with *) might result in stuttering and/or errors. Unsupported GPUs are automatically disabled.
Manual GPU selection requires macOS 10.15 or later.

To access the Preferences on a Mac, go to the DxO PureRAW menu; on a PC, go to the File menu. In both cases, the general options are:

- Language menu: Lets you select one of the available languages (German, English, Spanish, French, Japanese). Any change will take effect when the program is restarted.
- DeepPRIME Acceleration menu: see below.
- Cancel button: Exit Preferences without taking into account any changes.
- Save button: Take changes into account and exit Preferences.
The **DeepPRIME Acceleration** menu allows you to manage your graphics card's support for calculations and image processing.* This menu has the following options:

- **Auto selection**: Automatically selects the mode if the graphics card is compatible.
- **Use CPU only**: Forces DeepPRIME to use the CPU in case of problems with the graphics card.
- **Graphics card model**: Indicates the computer’s graphics card model and allows you to choose which graphics card to use if you have several.

* To see the list of supported graphics cards, see the System requirements page.

**Important:**

- Changing the DeepPRIME acceleration option requires restarting the program.
- Partially-supported graphics card models are indicated by an asterisk (*). In this case, you may experience errors and problems with smoothness.
- On the Mac, choosing between several graphics card models on the computer is possible only from macOS 10.15 and higher.

Help
The Help menu on both Mac and PC contains the following items:

- **DxO PureRAW Online User Guide** Accesses the home page of the online user guide. You can download a PDF of the user guide from here.

- **Keyboard shortcuts** Accesses the list of keyboard shortcuts.
- **Help**: Accesses the DxO support web page.
- **Check for updates**: Looks for updates on the DxO website.
- **About DxO PureRAW (PC)**: Opens the program splash screen, where you will find the version number and the legal notice.
- **What is DxO PureRAW?**: Opens a series of screens explaining the role and operation of the program (also displayed when using the program for the first time).

*Internet connection required.*
Interface
DxO PureRAW user interface

The DxO PureRAW user interface is divided into two screens:

- Adding and selecting photos
- Displaying enlarged photos

Adding and selecting photos

Adding and selecting photos screen

The Adding and selecting photos screen is divided into 5 sections (from top to bottom):

1. Process photos
2. Do of Deleted
3. Add photos to process or Drag & drop
4. Add photos to process
5. DxO PureRAW

Adding and selecting photos screen (Mac)
Adding and selecting photos screen (PC)

1. **Menu bar**: Contains the PureRAW and Help (Mac) or File and Help (PC) menus.

2. **Main toolbar**: Allows you to start optimizing selected photos, display, and manage DxO Optics Modules; sort the display of optimized and non-optimized images; specify the number of selected images; select images; display the contents of the destination folder for optimized images in a system window; and export images to third-party software.

3. **Secondary toolbar**: Includes a button to add images for optimization via a system window, and a button to purge DxO PureRAW of all previously added images.

4. **Image thumbnail display area**: Shows thumbnails of added images sorted by shooting date. When the area is empty of any thumbnails, it displays a button to add images for processing (via a system window) and a prompt to add images by dragging and dropping them into the area.

5. **Bottom bar**: Displays the DxO PureRAW icon, as well as the progress bar and estimated time remaining when optimizing images.

**Thumbnails**
When you add images to be optimized in DxO PureRAW, they are displayed as fixed-size thumbnails arranged in sections according to the date of shooting (in DD month YYYY format), with the most recent date always at the top of the display area. The program displays thumbnails in four ways:

1. **Original image, not processed, not selected**: Thumbnail of the original image, not optimized, with the file name, no frame.

2. **Processed image, not selected**: Thumbnail of the optimized image, without frame, with the new name (includes original file name + output format + DxO + optimization type + output file format extension) and a cyan diamond in the upper left corner indicating that the image has been optimized.

3. **Original image or processed image when hovered over**: When you move the mouse over the thumbnail, a gray frame is displayed. At the bottom right, click on the magnifying glass to switch to the enlarged display mode. A tooltip with the name of the file also appears if you hover your mouse over a thumbnail for a few seconds.

4. **Original image or processed image, selected**: A selected image has a frame and a cyan checkmark.

You can select thumbnails randomly by clicking on the images, and deselect them in the same way. To select a continuous series of images, click on the first one and then on the last one while holding down the Shift key.

Double-clicking on an image displays it enlarged, whether it is optimized or not.

When optimizing, a progress bar is displayed in the relevant thumbnail(s), in addition to the progress bar in the bottom bar.

**Right-click menu**

Right-clicking on a thumbnail or a selection of thumbnails displays a context menu that offers the following commands:
- **Process (n) RAW photos to JPEG or DNG**: Directly launches the optimization of the selected image or images.
- **Compare processing results**: Opens the optimized image in the enlarged view.
- **Export to application**: Opens the dialog box for exporting to a third-party application.
- **Display (n) files in Finder (Mac) or View (PC)**: Lets you access the destination folder and selected files in a system window (Finder on Mac, Windows Explorer on PC).
- **Remove 1 photo / Remove (n) photos**: selected photos are removed from DxO PureRAW but your original files will remain on the disk and not sent to the trash.

**Enlarged photo display**

**Overview of the display screen**

There are four ways to access the enlarged photo display screen:

- After optimizing the images, a dialog box asks if you want to see the results; click Yes.
- By double-clicking on a thumbnail, whether the image is optimized or not.
- By pressing the Space bar.
- By clicking on the magnifying glass when you move the mouse over a thumbnail.
The enlarged display screen lets you check the results of the optimization and gives you the possibility of comparing the optimized image with the original. The screen is composed of the following elements:

1. Image display area
2. Split frame separator, which you can move freely to the left or right.
3. The left section displays the original RAW file.
4. The right section displays the latest optimized image.
5. The filmstrip displays square thumbnails from the images in the thumbnail display (scroll with the mouse wheel).
6. You can show or hide the filmstrip by clicking on the chevron at the bottom of the currently displayed image.
7. The lower bar displays on the left the information related to the selected image (format, name, date and time of shooting, volume in MB and shooting parameters: ISO sensitivity, speed, aperture).
8. The lower bar also shows the number of images selected in the banner out of the total displayed.
9. Buttons for the different display modes (Adapted zoom, Zoom 1:1, Split view before/after, Comparison view by overlay).
10. Button to close and return to the Add and select photos screen.

Display modes
At the bottom right in the lower banner, you will find the buttons for the different display modes:

1. **Adapted zoom**: The image is displayed in its entirety.
2. **Zoom 100%**: The image is displayed at 100% (1:1 — that is, one pixel of the image is equal to one pixel on the screen).
3. **Split view**: Displays the image with a movable vertical separator; the original image is on the left and the optimized image is on the right.
4. **Toggle view**: Displays the optimized image and the original image alternately. Click and hold the mouse button to see the original image, release to return to the optimized image.

* Split and Toggle comparison views are available only when you have selected an optimized image.
100% (1:1) display

Split view
Toggle view: Optimized image (top), original image (bottom)
Progressive zoom and navigation

You can zoom in and out using the mouse wheel from the adapted view to a maximum of 1600% magnification. The zoom value is temporarily displayed at the top of the image. After zooming, you can move in any direction in the image by clicking and holding down the mouse.

Zooming works both with an original and an optimized image, including when using the split and the toggle comparison views.
Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>PC</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-screen mode</td>
<td>-</td>
<td>Cmd + Ctrl + F</td>
</tr>
<tr>
<td>Exit full-screen mode</td>
<td>-</td>
<td>Esc</td>
</tr>
<tr>
<td>Preferences</td>
<td>Shift + Ctrl + P</td>
<td>Cmd + ,</td>
</tr>
<tr>
<td>Display in Adapted mode</td>
<td>F3</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Display at 1:1 (100%)</td>
<td>F4</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Toggle comparison</td>
<td>Ctrl + D</td>
<td>D</td>
</tr>
<tr>
<td>Move from one thumbnail to another (filmstrip)</td>
<td>Left / right arrows</td>
<td>Left / right arrows</td>
</tr>
<tr>
<td>Show / hide filmstrip</td>
<td>Up / down arrows</td>
<td>Up / down arrows</td>
</tr>
<tr>
<td>Delete thumbnails</td>
<td>Delete</td>
<td>Cmd + Delete</td>
</tr>
<tr>
<td>Select thumbnails one by one</td>
<td>Shift + left / right / up / down arrows</td>
<td>Shift + left / right / up / down arrows</td>
</tr>
<tr>
<td>Select all thumbnails</td>
<td>Ctrl + A</td>
<td>Cmd + A</td>
</tr>
<tr>
<td>Exit results display mode</td>
<td>-</td>
<td>Esc</td>
</tr>
</tbody>
</table>
Adding and optimizing photos
Preparing photos for optimization

The first step in your DxO PureRAW workflow is to perform the following tasks:

- Adding photos
- Installing and managing DxO Optics Modules
- Selecting photos
- Emptying photos

Adding photos

DxO PureRAW does not allow you to import images directly from a camera or memory card. To do so, you will have to transfer the images to your hard drive using any software or utility you want. Once transferred to your hard drive, DxO PureRAW allows you to add photos either by fetching them from their storage folder, or by dragging and dropping them into the program screen from a Finder (Mac) or Windows Explorer (PC) window.

When using DxO PureRAW for the first time, the Add photos screen is empty and offers the following buttons and indications:

1. **Add photos to process** (indication and button in the image display area).
2. Drag and drop (indication in the image display area).
3. **Add photos to process** (button in the upper command bar).

Adding photos to optimize
Method 1 for adding photos:

1. Click on **Add photos to optimize** (either in the center or in the upper toolbar).
2. A system window will open: locate the volume and folder of the photos you want to add.
3. You can select either a folder containing images or one or more individual images.
4. Click on the **Open** button*.

5. The contents of the folder or the selected images are displayed as thumbnails in a dated section (DD Month YYYY). If the images were taken on different dates, there will be as many sections as there are dates.

6. The upper toolbar shows the path to the volume and folder of the added photos. If the images are spread over different folders and even volumes, the top bar will show **Multiple paths**.

* As soon as DxO PureRAW loads the images, the optical modules dialog box opens (see Installing and managing DxO Optics Modules, below).

Method 2 for adding photos:

- Open an image folder in a system window (Finder on Mac, Windows Explorer on PC).
- Enter a folder or a selection of images and drag and drop them into the DxO PureRAW screen. This action is possible even if there are thumbnails in DxO PureRAW already.
- The rest of the procedure is identical to the first method.

Method 3 for adding photos:

- Mac: Drag and drop one or more images onto the DxO PureRAW icon in the Dock. This action will open the program and display the images.
- PC: Drag and drop one or more images onto the DxO PureRAW alias on your desktop. This action will open the program and display the images.

Method 4 for adding photos:

- In the Finder (Mac) or Windows Explorer (PC), right-click on an image or selection of images and then, from the context menu, select **Open with DxO PureRAW**.
Installing and managing DxO Optics Modules

When adding images to DxO PureRAW for the first time, DxO PureRAW will automatically prompt you to download and install the DxO Optics Module(s) that correspond to the shooting equipment you are using, and whose information is contained in the EXIF metadata embedded in the images.

DxO Optics Modules let you correct the following lens defects and thus improve the image rendering:

- Vignetting: darkening of the image borders
- Distortion: deformation of straight lines
- Chromatic aberration: colored fringes along strongly-contrasted contour lines
- Lens sharpness: homogenenization and optimization of the entire image

Downloading and installing DxO Optics Modules

Once you have added your images, and if no DxO Optics Module is installed, a window will automatically open and offer to download and install the DxO Optics Module(s) corresponding to your shooting equipment — that is, the camera body and lens pair. (To do so, you will need an internet connection.)

The DxO Optics Module window comprises the following elements:
DxO Optics Modules

DxO Optical Modules are needed to apply custom optical corrections specific to your equipment. Please note that sometimes multiple modules will be applicable to some of your images. Please select, download, and save the one that corresponds to your equipment.

Select the equipment used to take jma-20191208-090526_(JMA_2422).NEF:

- Nikon D4 + AF-S Nikkor 24-70mm f/2.8G ED (To be downloaded)
- None of the above (correction won't be applied)

Select the equipment used to take _SIN0001.NEF:

- Nikon D850 + AF-S Nikkor 50mm f/1.8G (To be downloaded)
- None of the above (correction won't be applied)

Select the equipment used to take DSC_4116 D5.NEF:

- Nikon D5 + Sigma 24mm F1.4 DG HSM A (To be downloaded)
- None of the above (correction won't be applied)

[Buttons: Cancel, Download Selection, Save]
DxO Optical Modules are needed to apply custom optical corrections specific to your equipment. Please note that sometimes multiple modules will be applicable to some of your images. Please select, download, and save the one that corresponds to your equipment.

Select the equipment used to take _SiN7558.NEF:
- Nikon D850 + AF-S NIKKOR 300mm f/2.8G ED VR II  
  Currently in use
- None of the above (correction won't be applied)

Choose the equipment used to take 2 pictures like OBrunet_2018_1842_Ploumanach.CR2:
- Canon EOS 6D + Canon EF16–35mm f/2.8L II USM  
  846.5KB / 5.3MB
- None of the above (correction won't be applied)

Select the equipment used to take BBB-140629_213908_DxO 2.NEF:
- Nikon D4 + AF-S NIKKOR 70–200mm f/2.8G ED VR II  
  634.1KB / 2.3MB
- None of the above (correction won't be applied)
DxO Optical Modules are needed to apply custom optical corrections specific to your equipment. Please note that sometimes multiple modules will be applicable to some of your images. Please select, download, and save the one that corresponds to your equipment.

Select the equipment used to take _SN7558.NEF:

- Nikon D850 + AF-S NIKKOR 300mm f/2.8G ED VR II  
  (Currently in use)
- None of the above (correction won’t be applied)

Choose the equipment used to take 2 pictures like OBrunet_2018_1842_Pleumanach.CR2:

- Canon EOS 6D + Canon EF16–35mm f/2.8L II USM  
  (Downloaded)
- None of the above (correction won’t be applied)

Select the equipment used to take BBB-140829_213908_DxO 2.NEF:

- Nikon D4 + AF-S NIKKOR 70–200mm f/2.8G ED VR II  
  (Downloaded)
- None of the above (correction won’t be applied)

1. The detected DxO Optics Module to be downloaded*.
2. **None of the above**: If the proposed DxO Optics Module does not correspond to your shooting equipment, you can check this option to prevent any optical corrections.
3. **Download Selection**: Launches the download of the DxO Optics Module(s). If you don’t use them right away, DxO PureRAW will suggest them to you to use whenever you add photos taken with the corresponding equipment.
4. **Save**: Lets you validate the application of DxO Optics Module corrections.
5. **Cancel**: Closes the window without downloading or installing any DxO Optics Modules.

* In case of ambiguity — for example, the EXIF metadata does not allow the program to determine which model of lens was used because there are several versions or several generations — the window will offer you several possible choices; it is up to you to indicate which is DxO Optics Module is the right one.

You have three possible ways to deal with downloading DxO Optics Modules:
- Downloading and applying the DxO Optics Module. In this case, click on **Download the selection** and then click **Save**.

4 5
• Downloading but not applying the DxO Optics Module. In this case, click on Download the selection and then for each Module, select None of the above (correction won't be applied); the corrections will not be applied.

• Not downloading the DxO Optics Module. In this case, click on Cancel.

* If you do not install a DxO Optics Module, you will be able to make optical corrections in your usual image processing software. However, this applies only to files optimized in DNG format.

Managing DxO Optics Modules

The DxO Modules button displays the list of available or installed Optics Modules, and also shows their status, along with a visual indicator and a tooltip when hovering over a Module with the mouse:

1. No indication (default status): No photos added to DxO PureRAW.
2. Cyan check mark + No actions required*: All Modules for the selected photos have been downloaded and can be applied.
3. Yellow stop sign + Actions required*: At least one photo requires you to download the corresponding DxO Optics Module so it can be applied during optimization.
4. Button with cyan disk on top right + Review modules*: indicates that a new DxO Optics Module is available, replacing an existing one.

*The button turns cyan if you hover it with the mouse.

If you want to see a list of installed and pending Optics Modules, click on the DxO Modules button in the top bar. The window that appears is the same as the download window, and you can view the status of the DxO Optics Modules:
DxO Optics Modules

DxO Optical Modules are needed to apply custom optical corrections specific to your equipment. Please note that sometimes multiple modules will be applicable to some of your images. Please select, download, and save the one that corresponds to your equipment.

Select the equipment used to take _SiN7558.NEF:

- Nikon D850 + AF-S NIKKOR 300mm f/2.8G ED VR II 3
- None of the above (correction won’t be applied)

Choose the equipment used to take 2 pictures like 0Brunet_2018_1842_Ploumanach.CR2:

- Canon EOS 6D + Canon EF16-35mm f/2.8L II USM 1
- None of the above (correction won’t be applied)

Select the equipment used to take BBB-140629_213908 DxO 2.NEF:

- Nikon D4 + AF-S NIKKOR 70–200mm f/2.8G ED VR II
- None of the above (correction won’t be applied)

Buttons:
- Cancel
- Download Selection
- Save
DxO Optics Modules

DxO Optical Modules are needed to apply custom optical corrections specific to your equipment. Please note that sometimes multiple modules will be applicable to some of your images. Please select, download, and save the one that corresponds to your equipment.

Select the equipment used to take _Sin7558.NEF:

- Nikon D850 + AF-S NIKKOR 300mm f/2.8G ED VR II
- None of the above (correction won’t be applied)

Choose the equipment used to take 2 pictures like OBrunet_2018_1842_Ploumanach.CR2:

- Canon EOS 6D + Canon EF16–35mm f/2.8L II USM
- None of the above (correction won’t be applied)

Select the equipment used to take BBB-140829_213908_DxO 2.NEF:

- Nikon D4 + AF-S NIKKOR 70–200mm f/2.8G ED VR II
- None of the above (correction won’t be applied)

1. **Downloaded**: The DxO Optics Module is downloaded and installed (displays a progress bar during download, along with the volume).
2. **To be downloaded**: Lists the DxO Optics Module(s) waiting to be downloaded.
3. **Currently in use**: Indicates the DxO Optics Module you are currently using.

Note that you cannot delete a DxO Optics Module. However, these modules are small (a few MB each) and do not present any risk of using up the capacity of your hard disk.

Selecting photos

Selecting consists of choosing the photos you are going to optimize. You can select a single photo, a number of photos, or the entire contents of a folder.
The selected images have a cyan border and a check mark of the same color in the upper right corner of the images. To make your selection:

- A single image: Click on it.
- Several images that are not in sequence: Click successively on the desired images while holding down the Cmd key (Mac) or the Ctrl key (PC).
- Several images in a row: Click on the first image of the series, then click on the last image of the series while holding down the Shift key.

To select all the images displayed by DxO PureRAW at once, click the Select button on the right side of the top command bar. When images are selected, the button changes to Unselect all. Clicking it deselects all the selected images.

If you want to deselect only certain images, click in their thumbnails with the cyan border and remove the checkmark. But it's quicker to click on the Unselect all button.

Emptying photos

The Clear thumbnails button in the top secondary bar allows you to purge all images added to DxO PureRAW. This is useful when you have a large and regular production and you want to leave the interface empty of images when you need to add and optimize a new batch. Note that

- Original and optimized photos are removed only from DxO PureRAW and are not deleted from the original volume and folder.
- Installed DxO Optics Modules are also retained.
Optimizing photos

After having selected your photos, you are ready to optimize them. Optimization consists of applying optical corrections with DxO Optics Modules, and in proceeding to a partial demosaicing along with noise treatment, in order to generate either a linear DNG file, which preserves all the latitude of RAW files, for final processing in your usual development program, or to generate a ready-to-use JPEG file that you can share or publish immediately.

- Starting the photo optimization phase
- Selecting the RAW processing method
- Choosing the output format
- Choosing the destination folder
- Launching optimization
- Canceling or interrupting optimization

Starting the photo optimization phase
Optimizing photos starts with:

- Selecting the images to optimize.
- Ensuring that all the correct DxO Optics Modules have been installed and can be applied.
- Clicking on the Optimize photos button at the top left of the screen, or right-click on the image selection and choose Process (n) RAW photo(s) to JPEG or DNG from the pop-up menu.
- A floating window opens that offers to Process (n) photo(s).

Selecting the RAW processing method
In the **RAW processing** section of the floating window, choose by clicking on one of the three available methods:

- **HQ**: High Quality denoising method, preferred for combining both efficiency and speed.
- **PRIME**: Method using deep analysis of the image for optimal conservation of colors and details, without smoothing. The calculations are more intensive and the processing will take more time than HQ processing.
- **DeepPRIME**: Method based on artificial intelligence and producing higher-quality results than the other two methods.

The window displays an estimate of the processing and optimization time, which depends on several factors such as the choice of method, the number of images to be optimized and, of course, the power of your computer.

It is also possible that the optimization time will be longer with the basic HQ method than with DeepPRIME, which is a much more intensive process. This is likely because your graphics card (GPU) is probably much more powerful than your processor (CPU).

By hovering your mouse over the question marks, you will see a tooltip summarizing the differences between the noise optimization methods and the reasons for their respective times.
Choosing the output format

The RAW processing window also presents you with the choice of two output formats:

- **DNG**: Generates a linear DNG file that retains the characteristics and reversibility of the original RAW file,* allowing it to be further processed in a third-party program such as Lightroom Classic, Lightroom, or Camera Raw.
• **JPEG**: Provides a finalized, ready-to-use file. By selecting JPEG, you can adjust the level of compression and therefore the quality of the output file, on a scale of 10 to 100 (the default setting is 90). The lower the number, the higher the compression, and the worse the image quality.**

** Linear DNG is an RGB file type, so its size can be 2-3 times larger than the original RAW file.

** Optimization in DxO PureRAW does not affect the pixel dimensions, so output images retain the same number of pixels in width and height as the originals.

If you hover your mouse over the question mark, you will see a tooltip that explains the difference between the two formats and informs you of the impact on the respective output file size.

Choosing the destination folder

You have two options in the Destination Folder section:

- A ‘**DxO’ folder in the original image(s) folder**: Optimized images are automatically sent to a folder named DxO, inside the original images folder.

- **Custom folder**: Lets you choose and/or create a destination folder after clicking on the Browse button, which opens a system window. By default, DxO PureRAW proposes the operating system’s Images folder.

Launching optimization
Process 14 photos

RAW Processing

Method
HQ PRIME DeepPRIME

Estimated processing time: About 2 minutes

Format
Output format
JPg DNG

Destination folder
- 'DxO' folder in the original image(s) folder
- Custom folder
/Users/username/Pictures

Cancel Process

1
Once you have chosen the method and format, you can launch the optimization of the selected photos:

1. Click on the **Process** button.
2. The window closes.
3. A progress bar with the number of images already optimized, and the estimated time remaining are displayed in the lower bar of DxO PureRAW.
4. A progress bar also appears successively in the image thumbnails.
5. As soon as an image is optimized, the corresponding thumbnail is deselected, and the cyan border and checkmark are replaced by a cyan star in the upper left corner.
6. The image displayed is the optimized image, and replaces the original.
7. The name of the original is replaced by the name of the optimized photo and includes name original_DxO_method + extension (for example, IMG_0001_CR3_DxO_DeepPRIME.dng).
8. When the optimization of all the photos is finished, the progress bar indicates **Done**, then disappears.
9. A floating window informs you that the optimization is finished, and asks you if you want to **export your optimized photos to an external program**, to **see the results** in PureRAW, or to open the Images folder in a system window (Finder on Mac or Windows Explorer on PC). If you don’t want to see the images immediately, click on X in the upper left corner of the window.

During optimization, the metadata of the originals is preserved in the optimized images, including the EXIF data of the camera (shooting parameters, GPS coordinates, etc.), author and copyright information, star rating, keywords, and any information that you may have added to the IPTC fields (caption, location, etc.) in your photo management software.

**Canceling or interrupting optimization**
You can stop optimization as follows:

- Before starting optimization: In the method and format selection window, click on **Cancel**.
- Optimization in progress: In the lower bar, click on the **X** button at the right end of the progress bar.
Verifying and comparing photos

After optimizing your photos, and before sharing them (for JPEGs) or continuing making corrections in your favorite image processing software (for linear DNGs), DxO PureRAW offers you the possibility to check the results and easily compare them with your originals.

- Filtering photos
- Displaying, verifying, and comparing optimized photos

Filtering photos

The Add photos screen shows all the images, whether they are optimized or not. If the first ones have a cyan star in the upper left corner of the thumbnail, it may be difficult to distinguish them, especially if you have added many images and have processed only a random selection.
There are two filters located in the center of the main top banner, so you can separate the optimized photos from the originals:

1. **Processed** button: Displays only the thumbnails of the optimized images.
2. **Unprocessed** button: Displays only the thumbnails of the original images.

When you use these buttons, the thumbnails of the filtered photos are automatically selected (cyan border and checkmark). You can also click on both buttons to display both optimized and non-optimized photos at the same time. To disable the filters, click on **Cancel filters** above the buttons.

Displaying, verifying, and comparing optimized photos
Once you have optimized your photos, you can view and check them in a larger version in two different ways:

- Double-click on a thumbnail.
- Right-click on a thumbnail and select **Compare processing results** in the context menu.

With the split view, you can easily compare the optimized image with the original, as well as the effects of the DxO Optics Module on defects, sharpness enhancement, and noise. You can zoom into the image at 1:1 (that is, 100%) or you can use the mouse wheel to magnify.
the image up to 1600% to see the finest details.

You can use the left and right arrows on your keyboard to scroll through the images in the filmstrip. The checkboxes in the square thumbnails of the filmstrip allow you to select the images, even when you return to the Add photo screen (by clicking on the X button at the top right of the image), thus allowing you to immediately start exporting the selected images to your image processing program (see Working with optimized images).

For more information about display and comparison modes, see the DxO PureRAW user interface page.
Working with optimized images
Exporting to an application

DxO PureRAW does not have any image correction and processing tools, as its role is to produce a linear DNG file with perfectly-treated noise and lens flaws. It is an independent program, not a plugin. However, you can open linear DNG files in any photo program that supports this format.

- Exporting optimized images
- Exporting optimized images and original images

In this user guide you can see a detailed description of DxO PureRAW's workflow with Adobe Lightroom Classic and with Adobe Photoshop.

Exporting optimized images
3. Process 8 RAW photo(s) to JPEG or DNG
   Compare processing results
   Export 8 photo(s) to application...
   Display 8 files in Finder
   Remove 8 photo(s)

4. Export 8 photo(s)

5. Export to...
   Select a software
   Adobe Lightroom
   Adobe Lightroom Classic
   Adobe Photoshop 2021
   Adobe Photoshop Elements
   Select custom software...

6. Also export...
To export optimized images, do as follows:

1. In the Add photos screen, select the optimized images you want to export (you can use the Optimized filter, which displays only those images).

2. Click on the Export to... button in the upper right corner.

3. You can also right-click on the selection of images and in the context menu, choose Export to application...

4. The floating window shows the number of images to be exported.

5. DxO PureRAW will display a list of Adobe programs (Lightroom and Lightroom Classic, Photoshop and Photoshop Elements); select the one you want to use.

6. You can also choose another application. In this case, click on Select custom software and in the Applications folder (Mac) or the...
Programs folder (PC), select the desired program and click on Open.

7. The name of the destination program will appear in the window.

8. Click on Export.

9. The destination program opens and displays the exported images.

- Note that the Export window remembers the destination program.

- Exporting does not move the optimized files; they remain in their destination folder(s) defined at the processing stage.

Exporting optimized images and original images

The procedure for exporting optimized images together with the original images is the same as for exporting just optimized images, but with one additional step:

1. In the Add photos screen, select the images you want to optimize (you can use the Optimized filter, which displays only those images).

2. Click on the Export to button in the upper right corner.

3. You can also right-click on the selection of images and in the context menu, choose Export to application….

4. The floating window shows the number of images to be exported.

5. DxO PureRAW will display a list of Adobe programs (Lightroom and Lightroom Classic, Photoshop and Photoshop Elements); select the one you want to use.

6. You can also choose another application. In this case, click on Select custom software and in the Applications folder (Mac) or the Programs folder (PC), select the desired program and click on Open.

7. The name of the destination program will appear in the window.

8. To export the originals as well, check the Also export original raw file(s) option.

9. Click on Export.

10. The destination program will open with the exported images.
To export the originals, you will also need to make sure that the destination program supports them. If you are using an older version, check to see if there is an update that supports your images.
Workflow with Lightroom Classic

By generating linear DNG files that retain the characteristics and reversibility of RAW files, DxO PureRAW allows you to take advantage of DxO Labs’ expertise in image processing, while having the ability to perform all corrections other than noise and optical defects in the Processing module, and also to take advantage of Lightroom Classic’s cataloging, sharing, and publishing capabilities.

- Importing into Lightroom Classic
- Using a watched folder and automatic importing
- Processing images from DxO PureRAW
- Preparing images for optimization in DxO PureRAW

Importing into Lightroom Classic

Whether you exported photos optimized with DxO PureRAW to a folder or to a program, importing into Lightroom Classic proceeds in the same way.

Scenario 1: Importing from a folder
To import optimized photos from their destination folder:

1. Click on **Import** in Lightroom Classic.
2. In the Import menu, on the left pane, find and select the folder of optimized images.
3. In the Import menu at the top, choose the import mode (**Copy**, **Move** or **Add**).
4. In the right pane, choose your options and your usual import method (by date or by folder of origin). Note that in Add mode, you do not need to specify a destination.

5. Click on Import.

6. The optimized images are indexed and available in Lightroom Classic.

Scenario 2: Exporting directly from DxO PureRAW into Lightroom Classic

You can also export directly from DxO PureRAW as follows:

1. In DxO PureRAW, select the optimized images and then export them to the application.

2. Lightroom Classic comes to the forefront and its Import menu opens on the relevant images (you don’t need to search for and select the source).

3. In the right pane, choose your options and your usual import method (by date or by folder of origin).

4. Click on Import.

5. The optimized images are indexed and available in Lightroom Classic.

Using a watched folder and automatic importing

To take advantage of this scenario, which is particularly suitable for photographers who process many photos, you must first make certain settings, particularly on the Lightroom Classic side. Lightroom Classic can monitor a folder and trigger an automatic import as soon as it detects the arrival of new images in that particular folder.

This said, be careful: Since Lightroom Classic can monitor only one folder at a time, you will always have to use this folder as a destination for DxO PureRAW optimized images.

Preparation

In DxO PureRAW:
1. Define a destination folder.
2. Give the folder an explicit name — for example, "DxO PureRAW optimized photos."

In Lightroom Classic:
In the **File** menu, go to **Auto Import > Auto Import Settings**.

1. In the **File** menu, go to **Auto Import > Auto Import Settings**.
2. In the window that appears, in the **Watched Folder** section, click **Choose**, and then in the System window, find and select the folder to which you are sending your images optimized with DxO PureRAW. The control folder is the watched folder, and Lightroom Classic will move the photos to another folder.
3. In the **Destination** section, click **Choose** and then find or create the folder where Lightroom Classic will automatically move the images. Then, create a sub-folder by entering its name in the **Subfolder Name** field.
4. Make other settings according to your work habits (renaming, keywords, quality of previews, etc.).
5. At the top of the window, check **Enable Auto Import**.
6. Validate and then close the window by clicking **OK**.

**Use**
Automatic importing into Lightroom Classic is extremely simple:

1. Make sure Lightroom Classic is open.
2. In DxO PureRAW, optimize the photos in the destination folder that you have previously defined.
3. Return to Lightroom Classic: After a few seconds, the images optimized by DxO PureRAW will show up in the destination folder (see step 3 in the previous section) and are displayed.
4. The control folder (see step 2 in the previous section) is cleared.
5. You are now ready to continue managing and processing your images in Lightroom Classic.

Processing images from DxO PureRAW

**Status of optimized images imported into Lightroom Classic**

For images optimized in linear DNG format in DxO PureRAW and imported into Lightroom Classic, verify the following settings:
1. Lens corrections: Deactivated

2. Sharpness: All sliders must be set at 0.

3. Noise reduction: All sliders must be set at 0.

Possible corrections with Lightroom Classic*

If the JPEG files produced by DxO PureRAW are to be considered as ready-to-use images for sharing or printing, linear DNG files can be considered as RAW files that you will be able to correct without restrictions in Lightroom Classic:

- White balance
- Tone, automatic or manual (exposure, highlights, etc.), tone curve
- Presence (clarity, texture, haze correction, saturation, vibrancy)
- Color (HSL, color gradient, black & white conversion, etc.)
- Local retouching (brush, graduated filter, radial filter)
- Export to external editors (Photoshop, Nik Collection by DxO, DxO ViewPoint, DxO FilmPack, etc.)
- Creative tools
- Photo Merge (HDR, Panorama, Panorama HDR)
- Enhance (Super Resolution)
Corrections to avoid*

On the other hand, since DxO PureRAW has already made the following corrections, avoid using the following tools:

- **Lens corrections**: Do not combine DxO and Adobe optical corrections.
- **Noise reduction**: May cause smoothing of details and thus counteract the action of DxO denoising tools, especially DeepPRIME.
- **Sharpness** (in the Processing and Output Sharpness module): Use sparingly, as DxO PureRAW has already optimized sharpness.

* All this information also applies to the processing of optimized images in Photoshop’s Camera Raw development module.

Preparing images for optimization in DxO PureRAW

If you use Lightroom Classic to manage all your photos and plan to optimize them in DxO PureRAW (especially to produce linear DNGs), make sure to verify the following settings:

- **Lens corrections**: No profile applied.
- **Sharpness**: Gain slider at default value (40).
- **Noise reduction**: Luminance and Color sliders at their default values (0 and 25, respectively).

For images optimized in linear DNG format in DxO PureRAW and imported into Lightroom Classic, verify the following settings:

- **Lens corrections**: deactivated
- **Sharpness**: All sliders must be set at 0.
- **Noise reduction**: All sliders must be set at 0.
Workflow with Camera Raw and Photoshop

Using Adobe Photoshop to process the linear DNG files produced by DxO PureRAW goes first through Camera Raw, Photoshop's external RAW development. As its tools and possibilities are exactly the same as Lightroom Classic's processing module (see Workflow with Lightroom Classic), we will discuss here only the different ways to transfer and open files.

Methods of transferring and opening in Camera Raw
There are several ways to transfer and open DxO PureRAW optimized photos in Camera Raw:

1. Export to application: This is the DxO PureRAW export mode (see the Exporting to an Application page). The image or images exported to Photoshop will open in Camera Raw.

2. From the Photoshop home screen: Click Open.

3. In the system window that opens, find the destination folder with your optimized photos, select the desired image(s), and
click **Open**. The image or images will open in Camera Raw.

4. Directly in Photoshop: Go to the **File > Open** menu. In the system window that opens, find the destination folder with your optimized photos, select the desired image(s), then click **Open**. The image or images will open in Camera Raw.

5. Via Bridge: In Photoshop, go to the **File** menu and select **Browse in Bridge**.

6. Once Bridge is open, find the Optimized Photos folder, select the desired image(s), right-click, and choose **Open in Camera Raw** in the pop-up menu.

7. From Bridge: If you are using Bridge as your file explorer and manager, you can also open the images directly as in step 4, by right-clicking on the image selection and choosing **Open in Camera Raw**.

8. Pictures are open in Camera Raw.

Switching from Camera Raw to Photoshop

Once you have processed your images in Camera Raw, you have two options:

1. Do not retouch in Photoshop: In Camera Raw, click on **Done**. The corrections are saved.

2. Retouch in Photoshop: In Camera Raw, click on **Open**; the image opens in Photoshop (the small arrow on the Open button also allows you to open the image as a smart object, or to open a copy).

*For more information about the workflow in a Bridge / Camera Raw / Photoshop environment, refer to the help for these respective programs.*